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End-User License Agreement (EULA)

This End-User License Agreement (EULA) represents the contractual conditions 
between you, the Licensee, and UVI, located 159 rue Amelot, 75011 Paris - France 
for the use of software, documentation and other materials created by UVI. 

You should not register, install or use UVI Products until the 
following license agreement is understood and accepted.

By using UVI Products, or allowing anyone else to do 
so, you are accepting this agreement. 

A- License Grant
1. UVI grants to you, subject to the following terms and conditions, the 
non-exclusive right to use each authorized copy of the Product.

2. UVI Product license are granted only to a single user. You 
may use this product on up to three separate computers or iLok 
Dongles, which shall be owned and used by you exclusively. 

3. Renting or lending the licensed Software to a third party is expressly forbidden. 

4. Except if otherwise stated within this EULA, Licensee may resell the software 
to a third party or transfer the software permanently. Request may be done using 
the ‘Transfer License’ feature in your iLok account, subject to a $25 fee per-license 
($50 maximum) by Pace. The serial number of the Product will be transferred to 
the third party by UVI, and  Licensee’s original registration will be deleted.

5. Resale or ownership transfer of individual products obtained in a bundle, or 
those used to upgrade or cross-grade to other products are not allowed.

6. UVI allows you to use any of the sounds and samples in the products 
you’ve purchased for commercial recordings without paying any 
additional license fees or providing source attribution to UVI.

7. This license expressly forbids resale or other distribution of the sounds and 
software included in the Product or their derivatives, either as they exist on disc, 
reformatted for use in another digital sampler, or mixed, combined, filtered, 
resynthesized or otherwise edited, for use as sounds, multi-sounds, samples, 
multi-samples, wavetables, programs or patches in a sampler, microchip or any 
hardware or software sample playback device. You cannot sell the Product content 
or give it away for use by others in their sampling or sample playback devices. 

8. In the event UVI terminates this agreement due to your breach, you agree to 
return the original and all other copies of the software and documentation to UVI.

9. UVI reserves all rights not expressly granted to herein.

B- License Activation
1. In order to use UVI Products it is required that you authorize them by 
registering your Serial Number on uvi.net/register, have a free iLok account 
(not necessarily a dongle) and install the free iLok License Manager (done 
automatically by UVI Workstation and Falcon installers). It is impossible 
to use UVI Products if they are not registered and authorized.

2. During authorization you will need to enter your name, email address and 
postal address which will be stored in the UVI database. UVI uses a secure SSL 
connection with 128-bit-encryption that meets current security standards 
to transmit your data over the web. For further information about UVI’s 
handling of personal data please see: https://www.uvi.net/privacy-policy

3. The UVI Product license allows up to 3 simultaneous activations on any 
combination of iLok dongles and computers. Activations can be moved 
between devices at anytime through the iLok License Manager.

C- Protection of Software
You agree to take all reasonable steps to protect the Product and any accompanying 
documentation from unauthorized copying or use. You agree not to modify the 
Product to circumvent any method or means adopted or implemented by UVI to 
protect against or discourage the unlicensed use or copying of the Product.

D- Ownership
Ownership of, and title to, the enclosed digitally recorded 
sounds (including any copies) are held by UVI.
Copies are provided to you only to enable you to exercise your rights under the license.

E- Term
This agreement is effective from the date you open this package, and will remain in 
full force until termination. This agreement will terminate if you break any of the terms 
or conditions of this agreement. Upon termination you agree to return to UVI all copies 
of this product and accompanying documentation and destroy any other copies made.

F- Restrictions
Except as expressly authorized in this agreement, you may not 
rent, lease, sub-license, distribute, copy, reproduce, display, modify 
or timeshare the enclosed Product or documentation. 

G- NFR Serials and Free Products
UVI Products serial numbers labeled as “NFR” (Not For Resale) shall only be 
used for demonstration, testing and evaluation purposes. NFR Products may 
not be used for commercial purposes, and may not be resold or transferred.
They are not eligible for license recovery and are exempt from update, 
upgrade or crossgrade offers, and cannot be purchased with or exchanged for 
vouchers. Furthermore, as an owner of an NFR Product, you are not entitled 
to promotions available for the commercial version of the Product.

H- No Support Obligation
UVI will make its best effort to support you in the event of technical difficulty with a 
UVI Product. However, UVI is not obligated to furnish or make available to you any 
additional information, software, technical information, know-how, or support.

I- Specifications and System Requirements
All technical specifications of UVI Products provided are intended to be estimates 
or approximations. Due to numerous variables no guarantees of compatibility 
or performance can be made. All such specifications shall be in writing.
End-User is solely responsible for, prior to purchase, ensuring that End-User’s 
devices are compatible and meet the system requirements for UVI Products, 
and that the applicable UVI Products meet End-User’s requirements.

This EULA is governed by the laws of France.

 

©2017 UVI. All rights reserved.
All trademarks are the property of their respective owners.

Do not use this product until the following license agreement is understood and accepted.
By using this product, or allowing anyone else to do so, you are accepting this agreement.
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In the summer of 1986 a renowned American synth manufacturer 

released a machine with a remarkable new method of constructing 

sound. That machine was the Sequential Prophet VS and the method 

was vector synthesis. A ground-breaking instrument in its time and 

still a sought-after collectible to this day, the Prophet VS was ill-fated 

in the market for a number of reasons and its failure signaled the 

end of Sequential’s distinguished legacy. Needless to say the tonal 

range and sheer flexibility of the Prophet VS was brilliant. The new 

digital vector synthesis engine was placed in front of an all-analog 

signal path with renowned Curtis amps and filters giving it incredible 

warmth and an unmistakable character. The palette of sounds that 

were possible with the VS was immense. Not only did it offer a world 

of never-before heard sounds but it could closely imitate both the 

analog classics and its modern digital peers alike. Another first, the 

Prophet VS saw great emphasis placed on expressive control over a 

stereo sound stage allowing for great depth and dimension, leading 

in large part to it capturing the imagination of an entire generation of 

film composers including the seminal Vangelis and John Carpenter.

Vector Pro begins with one of these rare treasures, a fully serviced 

Sequential Prophet VS. Sound designers in our studio poured over 

and through this machine to create a multitude of patches, from 

textbook classics to the wild and experimental, resulting in a true 

exposition of the machines capabilities. These patches were then 

multi-sampled through a world-class system at high-resolution, 

capturing every detail. While no sample-based instrument can ever 

be definitive in a true sense, Vector Pro offers a staggeringly thorough 

depiction of the Prophet VS with a 30gb library of sample data. 

Filtering, modulation, expression and effects are all realized with the 

capable UVI Engine, offering near-limitless customization options. 

Two basic architectures are provided in Vector Pro, VS and VX. Vector 

Pro VS offers an efficient and flexible single oscillator system which 

expresses quite unmistakably the qualities of the Prophet VS. Vector 

Pro VX takes things a step further with a dual-layer system built 

on a library of raw multi-sampled waveforms. This system allows 

for the exploration of completely new sounds with independent 

control of each layers amp, filter, stereo and effects sections, a 

built-in LFO, step modulator and two versatile arpeggiators. User 

interfaces for both recall the classic design of the Prophet VS and 

sport a full array of programmable controls that should be both 

immediate and intuitive to anyone with synthesizer experience.

As a bonus we’ve included Vector Pro 22. Made in the same depth 

and fashion as Vector Pro VS, Vector Pro 22 details the classic 

Yamaha SY22 vector synthesizer. The SY22 was designed by 

former Sequential engineers after Yamaha purchased the group 

and is loosely based on the Prophet VS architecture. Offering 

its own unique character and modulation opportunities, the 

SY22’s sound makes a perfect compliment to the VS library.

Vector Pro offers a huge range of sounds of both impeccable 

quality and distinct character. A great sounding instrument 

sure to please sound designers, producers, composers 

or anyone else looking for sonic inspiration.

Minimum System Requirements

• UVI Workstation 2.5.10+ or Falcon 1.0+

• 18GB of disk space

For more information on the installation process, please refer to 

the document: Soundbank Installation Guide

Introduction

http://www.uvi.net/installing_uvi_soundbanks_en.pdf
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VS - Edit Page

1  Globals + Page
» Mono

Disables polyphony if active

» Arp

Toggle built-in arpeggiator on/off 

[additional controls available in UVIWS/

Falcon arp page]

» Edit

Sets the UI to the Edit page

» Mod

Sets the UI to the Mod page

2  Filter
» ADSR

Typical envelope controls for the filter

» Vel Sens

Adjust the filter velocity sensitivity

» Depth

Depth of the filters EG

» Cutoff Freq

Filter cutoff frequency

» Resonance

Filter resonance amount

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

3  Amp
» ADSR

Typical envelope controls for the amp

» Velocity

Adjust the amp velocity sensistivity

» Vel > Atk

Remaps Attack to Note Velocity

4  Modwheel
This section provides a quick way to 

map common controls to your MIDI 

keyboards modwheel

» Vibrato

Speed of the vibrato (free)

» Tremolo

Speed of the tremolo (sync)

» Filter

Cutoff frequency of the Filter

5  Effects
» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

6  Noise
» Amount

Adjust noise mix amount

» White/Pink

Select white or pink noise types

The UI is divided into two pages; [Edit] and [Mod]. Primary controls such as amp, filter, stereo, pitch and effects are available on the [Edit] page. Clicking 
the [Mod] button at the top of the interface reveals the second page of controls containing the LFO and Step Modulator. Presets are accessible directly 
through the browser in UVI Workstation/Falcon.

Globals + Page

Noise

Effects

Amp

Filter

Modwheel

1

6

5

3

2

4
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VS - Edit Page  [continued]

Stereo

Drive

Pitch

7  Stereo
» Color

Utilizes neighboring samples from the 

library to a unique effect

» Spread

Sets the stereo width (in ALT and UNI 

modes only)

» Detune

Detunes the unison layers (UNI mode 

only)

» Mode - Off

Sets the stereo mode to OFF 

(monophonic)

» Mode - Alt

Sets the stereo mode to ALT; stereo 

position alternates L/R every note, width 

controlled by [SPREAD]

» Mode - Uni

Sets the stereo mode to UNI; layers 

multiple samples and augments them for 

increased stereo presence, modify with 

[COLOR] and [DETUNE]

» Mode - Chorus

Activates hardware Chorus layer

8  Pitch
» Depth

Sets the depth of portamento [Poly]

» Time

Sets the glide time for both modes

9  Drive
» Amount

Sets the drive amount

» On/Off Switch

7

9

8
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VS - Mod Page

LFO

Step Modulator

1  LFO
» Sync

Toggle LFO sync to host tempo

» Speed

Set the LFO speed

» EG Depth

Set the depth of the LFO envelope

» Attack

Set the LFO envelope attack time

» Decay

Set the LFO envelope decay time

» Shape

Select the LFO waveform: Sine, Square, 

Triangle or Sample & Hold (random)

» > Pitch

Set the pitch modulation amount

» > Drive

Set the drive modulation amount

» > Volume

Set the volume modulation amount

» > Filter

Set the filter modulation amount

2  Step Modulator
» Step Value

Set the per-step value (draw with 

mouse, double-click to enter explicit 

values) 

» Grid

Set the step speed/resolution

» Steps

Set the number of steps to playback

» Delay

Set the initial delay time

» Rise

Set the time to activate smooth

» Smooth

Interpolates sub-step values for a 

smooth modulation

» > Volume

Set the volume modulation amount

» > Filter

Set the filter modulation amount

  Saving Presets
» UVI Workstation

1. Click the [Multimode] button in the 

main toolbar

2. Click the [Wrench] icon

3. Select ‘Save Multi’

» Falcon

1. Click the [Wrench] icon and save as a 

Multi (all parts) or as a Program [single]

Settings for both UVI Workstation and 

Falcon will be saved automatically with 

your project if you’re working within a 

DAW.

1

2
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Preset List - VS

Arpeggios-Steps:
Analog Tanger
Mayhem of Steps
New World Order
Orbital Wheel
Parasitiac
Playing Land
RinoceChord
Space Transmission
Step Dirty
The Discover
Vectorification
Wheel Delay

Bass:
Anabass
Diplodobass
DNA VS Wheel
Glasswheel
Jarstice
Mati Bass
Mog Bass
Shaft VS
Slapotron
Square Wheel
Vector Bass
Vector Slap
Video Games
VSub Bass
Yeti Foot
Zebroid

Bells-Mallet:
Classic VS
Digi Mallet
Digital Bellstation
Evolubells
Fairlight B
Florin Bells
GIK Digital
Little Bell
Numericabel
Pluck Wood
PPG Like
Prophet Bells
Soft Orgabells
Space Carillon
Steely Drums
Sunlight
Synth Tiny Bells
That VS Bell
Tubular
Vector Bello
Wolf Band
Woody VS
Zanga Bella
Brassy:
Cold Brass
Kevin Brass
OB Stew Fly
Synth Brass
Vector Hybrass

Keyboards:
Almost Grand
Clavi Phase
Digital Road
Fender Bells
Funky Soft
HarpVSichord
Little Piano
Metalicia K
More than FM
Morphed Keys
NumeriClav
OrgAfrica
Pro Dyno
Prophet Road
ReggAttack
Rootsrgan
Soft Harpsy
Soft Organ
Space Keys
Spacial Keys
Tramp Super
Vector Road
VectorGan
VS Rlitzer
VS Tines

Leads:
Analead
Bob Corn
Eleadstic
Ethiopian Lead
Fivotron
Funky Beach
God Given
Harvard Square
Leadotron
Long Beach
Mad Justice
Mog Lead
Poly Age
Shaft Lead
Smoothy
Solage
Solivox
Solo Nono
Vanilla Lead

Pads:
Cold and Calm
Dark Pador
Detuned Voices
Evolution
Harry Zone A
Hybridizer
Islandia
Larger Voices
Mellocoton
PaDyno
Panichoirs
Phasy Holly
PolaVocaroid
Polymorphe

Pomade
Rain Forest
SFX Bell Pad
Soft Choir
Soft Tines
Sorin Pad
Step Padder
Vocal Ensemble
Vox Digitali
VP Choirs Like
Yes You Are

Polysynth:
Anafunk
Big Stack
Clintonix
Complex City
Digital Stack
Funky Smooth
Hybrid Poly
Metal Poly
Moving Tune
Nueva Poly
Organ Funky Stab
Panicota
PoLead
Poly Back Feed
Polypad
Raw Square
Resophonic
Softy Brassy Poly
Squarly
Stack Anovist
Table Top
Thriller Droid
Ze Cycle

Strings:
Analog STR
Eminent
Hybrid Baroque
Ominous VS
Phaser Strings
String Machine
Vector Fast Strings
Vector Slow Strings
VoxChestra

Sweeps:
Bottle Sweep
Equinox
Fast Sync
Invert Jarre
Multi Sweep
Poly Sweep
Soft Sweep
Square Sweep Step
Sweepy Martinez
UVI Filter Sweep
Wheel Glassweep

Xtra Waveforms
Bells:
Bass Bell
Bell Partials 1
Bell Partials 2
Bells 01
Bells 02
Bells 03
Bells 04
Bells 05
Bells 06
Bells 07
Bells 08
Bells 09
Bells 10
Bells 11
Bells 12
Bells 13
Bells 14

Brutal:
1-Heavy Seventh
Brutal 01
Brutal 02
Brutal 03
Brutal 04
Brutal 05
Brutal 06
Brutal 07
Brutal 08
Brutal 09
Brutal 10
Brutal 11
Brutal 12
Brutal 13
Brutal 14
Brutal 15
Brutal 16

Chip Tune:
Chip Tune 01
Chip Tune 02
Chip Tune 03
Chip Tune 04
Chip Tune 05
Chip Tune 06
Chip Tune 07
Chip Tune 08
Chip Tune 09
Chip Tune 10
Chip Tune 11
Chip Tune 12
Chip Tune 13
Chip Tune 14
Chip Tune 15

Digital:
3rd and 5th
Digital 01
Digital 02
Digital 03
Digital 04
Digital 05

Digital 06
Digital 07
Digital 08
Digital 09
Digital 10
Digital 11
Digital 12
Digital 13
Vocal

Organ:
Organ 01
Organ 02
Organ 03
Organ 04
Organ 05
Organ 06
Organ 07
Organ 08
Organ 09
Organ 10
Organ 11
Organ 12
Organ 13
Organ 14
Organ 15
Organ 16
Organ 17
Organ 18

Pure:
Pure 01
Pure 02
Pure 03
Pure 04
Pure 05
Pure 06
Pure 07
Pure 08
Pure 09
Pure 10
Pure 11
Pure 12
Pure 13
Pure 14
Pure 15
Vocal

Thin:
Thin 01
Thin 02
Thin 03
Thin 04
Thin 05
Thin 06
Thin 07
Thin 08
Thin 09
Thin 10
Thin 11
Thin 12
Thin 13
Thin 14

Waves:
01-Sine
02-Saw
03-Square
04-Pulse 1
05-Pulse 2
06-Saw 3rd and 5th
07-Sine 5th
08-Sine 2-Oct
09-Sine 4-Oct
10-Saw 5th
11-Saw 2-Oct
12-Square 5th
13-Square Oct and 5th
14-Square 2-Oct
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VX - Edit Page

The UI is divided into three pages; [Edit], [Mod] and [Arp]. Primary controls such as amp, filter, stereo, pitch and effects are available on the [Edit] page. 
Clicking the [Mod] button at the top of the interface reveals the second page of controls containing the LFO and Step Modulator. The final [Arp] page 
presents an independent arpeggiator for each layer.

Presets

Layer Globals

Edit

Pitch

1

3

5

6

Main

1  Presets
Select a global preset from the pull-

down menu or browse them with the 

Prev/Next arrows

2  Pages
Change the current page by selecting 

one of the 3 options; Edit, Mod or Arp

3  Layer Globals
» On/Off Toggle

Turn layers 1 and 2 on or off

» Volume

Adjust the Volume of each layer

» Pan

Adjust the Pan of each layer

4  Master Gain
Set the Output Gain for the instrument

Basic Controls

5  Layer Edit
» Edit 1 | Edit 2 | Edit All

Choose to edit layers 1 or 2 seperately or 

simultaneously

» Wave Menu

Choose the wave category in the first 

row and the wave in the second

6  Pitch
» Tune

Adjust the pitch in Semitones/Cents

» Depth

Adjust the Portamento depth

» Mono

Toggle between Mono and Poly voicing

» Octave

Adjust the pitch in Octaves

» Time

Set the Glide time

7  Amplitude
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Amplitude section

» Velocity > Attack

Modulates attack amount based on 

incoming note velocity. Low velocities 

result in long attacks; high velocities 

result in short attacks.

» No Velocity

Sets all incoming notes to max velocity

8  Drive
» On/Off Switch

» Amount

Sets the amount of drive

Pages

Master Gain

Amplitude

Drive

2

4

7

8
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VX - Edit Page  [continued]

Modwheel

Stereo

12

9

Filter

Effects

10

11

Basic Controls (continued)

9  Stereo
» Mode

Off / Alternate Pan / Unison

» Color

Shifts color based on adjacent samples

» Spread

Change the stereo width

» Detune

UNI Mode Only: setunes layers

10  Filter
» ADSR

Attack / Decay / Sustain / Release 

envelope for the Filter section

» Cutoff

Filter cutoff frequency

» Resonance

Adjust the resonance (Q) of the Filter

» EG Depth

Modifies the amount of ADSR envelope 

to be applied to the Filter

» Velocity

Adjust the Velocity > Filter sensistivity

» Type

Choose Filter mode; High Pass, Band 

Pass, or Low Pass

11  Effects
» Power/Amount

Choose from Phaser, Delay, Reverb and 

Chorus (additional controls available in 

the Effects page of UVIWS and Falcon)

12  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth
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VX - Mod Page

Sync

Step Sequencer

1

5

Waveforms

Params

Mod Routing

Mod Routing

LFO Controls

2

6

7

4

3

LFO

1  Sync
Enable/Disable LFO sync to Host Tempo

2  Waveforms
Choose LFO waveform; Sine, Triangle, 

Square or Sample & Hold

3  LFO Controls
» Speed

Change the LFO Speed

» EG Depth

Adjusts the amount of Attack and Decay 

to be applied to the LFO

» Attack

Attack time for the Speed envelope

» Decay

Decay time for the Speed envelope

4  Mod Routing
Control the amounts of LFO modulation 

to be applied to various parameters 

including; Pitch, Drive, Volume and Filter

 

Step Modulator

5  Step Sequencer
Interactive editor for programming 

sequenced modulations; bar height 

equals mod amount

6  Params
» Grid

Change the sequencers step length

» Steps

Change the amount of steps for the 

sequencer to play

» Delay

Delay time to activate first step

» Rise

Time to activate step with a smooth 

transition

» Smooth

Interpolates values between adjacent 

steps to smooth parameter modulation 

for a custom LFO effect

7  Mod Routing
Control the amounts of modulation to be 

applied to various parameters including; 

Volume and Filter
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VX - Arp Page

Step Indicator

Step Editor

Tie

1

2

3

Arp On/Off

Grid

Arp Mode

Layer 1 > Layer 2

Steps

Gate

Octave

5

6

7

4

9

8

10

1  Step Indicator
LED lights up when step is triggered

2  Step Editor
16-step sequencer; affects Velocity

3  Tie
When active, step inherets Velocity from 

the previous step

4  Layer 1 > Layer 2
When active, Arpeggiator 1 affects 

both layer 1 and layer 2 (whereas 

when disabled each Arp modifies its 

corresponding layer only)

5  Arp On/Off
Toggle the Arpeggiator On/Off

6  Grid
Change the step length

7  Arp Mode
Select Up, Down, or Up and Down

8  Gate
Change the step length (knob value 

ranges from zero to the tracks 

Resolution setting)

9  Steps
Sets the Arpeggiators step length

10  Octave
Set the pitch range of the Arpeggiator 

in Octaves
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Preset List - VX

00-Init

Arpeggios:
AR-Cosmo Wheel
AR-Diode Power
AR-Hernani
AR-Kitch Pop Corn
AR-Lake O Neil
AR-Liquid Emo
AR-T Show
AR-The Phoenix
AR-Vector Hugo
AR-Very Wheel
AR-Zenitude

Bass:
BS-Dub Punk
BS-Fusion Wheel
BS-God Given
BS-Hurry Fashion
BS-Jack in The Bass
BS-Rage Analog
BS-So Phat
BS-Sub Culture
BS-Super Wet
BS-Wheel Take Us
BS-X Seq Mania
BS-You and Bass
BS-Zebra Wheel

Bells:
BL-Analog Bell 1
BL-Belly Bello
BL-Broken Bells
BL-DigiBell One
BL-DigiBell Two
BL-Dulce De Leche
BL-Ego Bells
BL-Monster Mos
BL-Osphore Bells
BL-Ring My Bell
BL-Solarium
BL-Square Bells
BL-Unity
BL-Vibrations
BL-Wheel Bell
BL-Wheel Mutan

Brass:
BR-Abrasic
BR-Coach O New
BR-Old Movie
BR-Simple Funk Brass
BR-Slow Motion

Chords:
CH-Activation
CH-Aliens Wheel
CH-Arp Chordix
CH-Bi Cephale
CH-Big Beauty
CH-Mother Guez
CH-Multisonic
CH-Windax Boxer
CH-Yes you Can
CH-Zebuloid
CH-Zoologic

FX:
FX-Cochon in Space
FX-Mansion
FX-Neptoms

Keyboards:
KB-ClaVector
KB-CP Impressions
KB-Dyno VS
KB-Harpsonic Castle
KB-Keys VS Seq
KB-Lunar Organ
KB-Organix
KB-Prophet Tines
KB-Synth Cheezy
KB-The VX Doors
KB-Vintage Vibes

Leads:
LD-Duck Dance
LD-Entrance
LD-FeedbacKing
LD-Giga Bass Lead
LD-Nasaloide
LD-Overwheeling
LD-Screamer
LD-Seq BAF
LD-So Digital

LD-Solo Poly Wheel
LD-Vintage Lead
LD-Vocal Theremin

Pads:
PD-ARP Ominous
PD-Beautypad
PD-Captain Cousteau
PD-Cold Waves
PD-Creative Wheel
PD-Dancer in the Dark
PD-Dual And Lua
PD-Filter Sweep
PD-Morpho
PD-Network Reso
PD-Nineties
PD-Noise Beat
PD-Padamento
PD-Sol Air One
PD-Sweepy Morales
PD-Tanger Wear
PD-Vocal Gliding

Plucks:
PL-Busy Times
PL-Digital Wheel
PL-Glass Lounge
PL-Numericharp
PL-Polymentos
PL-Polyson
PL-Soly Polo
PL-Sugar Man
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22 - Edit Page

Stereo

Mono/Poly

Amplitude

Pitch

Drive

Bit Crusher

2

1

3

5

6

7

1  Mono/Poly
Switch between mono and poly modes

2  Stereo
» Mode - Off  (mono)

» Mode - Alt

Stereo position alternates L/R every 

note, width controlled by [SPREAD]

» Mode - Uni

Layers multiple samples and augments 

them for increased stereo presence

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Spread

Sets the stereo width

» Tune

Detunes the unison layers (UNI mode)

3  Amplitude
» Vel > Atk

Remaps Attack to Note Velocity

» ADSR

Typical envelope controls for the amp

» Velocity

Adjust the amp velocity sensistivity

4  Filter
» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

» ADSR

Typical envelope controls for the filter

» VEL

Adjust the filter velocity sensitivity

» CUT

Filter cutoff frequency

» RES

Filter resonance amount

» ENV

Depth of the filters EG

5  Pitch
» Depth

Sets the depth of portamento [Poly]

» Time

Sets the glide time for both modes

6  Drive
» On/Off Switch

» Amount

Sets the drive amount

7  Bit Crusher
» Bit Crusher On/Off

 Enable/Disable the Bit Crusher effect

» Bit

 Set the bit reduction

» Frequency

 Set the Bit Crusher sample rate

» Drive

 Adjust the overdrive amount of the 

 Bit Crusher effect

8  Effects
» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

9  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth

Filter

Effects

Modwheel

4

8

9
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Preset List - 22

Bass:
Agressynth
Back in the days
Bassy Dub
Danger in Boots
Dead or a Bass
Eighties Bass
Funkitch Slap
Jazz Acoustic
Just Ice Bass
Keetchew Bass
Music Man
No Fret
Obese Vector
Square Bass
Switch
Toy Bass
Vectorgelis
Welcome Zapp

Bells:
Airy Bells
Asian Bells
Blow Bells
Chandel Bells
Children Box
Digital Bells
Dream my Bell
Farfibells
Glock and Spiel
Metal Licks
Mixed Bells
Origami
Pure Bells
Vector Bells

Brass:
Analog Brass
Cheezy Brass
Cheezy Trumpet
Crawl Brass
FM Band
Frenchies One
Hooks Machine
Horn Section
Large Horns
OBrass
Poly Brassy Endy

Poly Brassy
Synth Brass

Guitars:
Distortion Poly
Distortion Solo
Distortion
Harmonics
Harpybrid
Muted
Tiny Electric
Twelve Strings
Ultra Short

Keys:
AcoustHybrid
Arial Keys
Chandel Dyno
Clavector
Concert Pad
Crystal Space
Digital Keys
ETines
Farfitoys
FM History
Gospel Tines
Grand Pad
Grand Twenty Two
Hard Psychord
Hybrid Keys
Keyvolution
Pianissimo
Pop Organ
Smooth Jazz
Think Clav
Toy Piano
Vector Keys
Vectorgan
WurlEctor

Leads:
Digital Pan Flute
Harmo 22
MalleadT
Noise Lead
OsciVector
Quincy Pan
Rasp Berries

Square El
Switch Lead
Vangelead
VectOboer
Vector Sync

Misc:
Barbabian Flute
Barbabian
Cheezy Sax
DrumStation
Ethnicity
Hybrid Mallet
Incarnation
Melloflutron
NepToms
Scratch Hall
Synth Pan Flute
Vector Marimba
Woody Vector

Orchestral:
Baroque Strings
Classical Horns
Complete Section
Dark Strings
Full Church
Harp Edge
Large Vectorch
Low Ensemble
MajestHit
OrchestrOrgan
Pizzicator
Rainbows
Simple Harp 
Solino
Tutti Vector
VectHollywood
Vector Hits
Victory GO

Pads:
Atonal
Cirque Evolution
D Fifty
Feeric
Full Pad
GrandOminous

Icono Blast
OBminous
Old Field
One Again Beast
Pad Problem
Padlywood
Slow Heaven
Warm Session

Vector Synth:
Beauty Full
Citrix Acid
Detuned
Ethereal Drops
German Dream
Motion Synth
Moving Waves
Multi Pad
Night Sensation
Poly Vector
Soft Funk
Square Pluck
Vector Punch
Wobbling

Voices:
Boys Ensemble
Destructuration
Detail Evil
Focal Choirs
Mind Blowing
Obee Choirs
Raining Choirs
Short Vox
Slow Boys
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Links

UVI

Home                                                                                     uvi net/ 

Soundbank Installation Guide                                                         installing_uvi_soundbanks_en pdf 

UVI Workstation User Guide                                                           uviworkstation_user_guide_en pdf 

Your Registered Product Serial Numbers and Download Links                  uvi net/my-products 

FAQ                                                                                       uvi net/faq 

Tutorial and Demo Videos                                                             youtube com/

Support                                                                                   uvi net/contact-support 

iLok

Home                                                                                     ilok com/ 

iLok License Manager                                                                  ilok com/ilm html 

FAQ                                                                                       ilok com/supportfaq 

http://www.uvi.net/
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/my-products
http://www.uvi.net/faq
https://www.youtube.com/user/UVIofficial
http://www.uvi.net/contact-support
http://www.ilok.com/
https://www.ilok.com/ilm.html
https://www.ilok.com/#!faq
https://www.ilok.com/#!faq


Produced by UVI

Recording / Editing / Sound Design
Damien Vallet

Kevin Guilhaumou
Alain J Etchart

Nathaniel Reeves
Kenneth @ Maskinrum Studio

Software + Scripting
Olivier Tristan
Remy Muller

GUI
Nathaniel Reeves

Documents
Nathaniel Reeves

Kai Tomita

Special Thanks
Michael Garçon

Richard @ RL Music
Manu @ Master Waves

Kenneth @ Maskinrum Studio

Credits and Thanks
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